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1 GETTING STARTED 

 

This section provides start-up instructions for using the Oracle applications. 
 

 
 

1.1 Sign-On to Cloud applications 
 

To log into the application: 
 

1.  Open internet browser window. 
 

2.  Enter the below URL: 
 

 

No. 
 

URL Type 
 

URL Link 

 

1. 
 

TEST 
 

https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/ 

 

2. 
 

PROD 
 

https://fa-etei-saasfaprod1.fa.ocs.oraclecloud.com/ 

 

Table 1: Direct Login URL 
 

 
3.  The Sign In page appears. Enter your User ID and Password. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1: Oracle Cloud Sign-In Page 
 

 
4.  Your user ID and password are case sensitive. Passwords always appear as asterisks 

in the display as you enter them. 
 

5.  Tab to or click the  button to sign in. 
 

6.  Personal Homepage dashboard screen appears with CLOUD privilege access. 

https://fa-etei-saasfaprod1.fa.ocs.oraclecloud.com/
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1.2   Navigating from Personal Home Page to Applications 

 

 
After you log in to Oracle Applications, your Oracle Procurement Cloud Home page is 
displayed. All the functionality within the Oracle Cloud applications revolves around homepage 
which you can personalize. From here you can: 

 

 
1.Get a quick glance at your work-related conversations and announcements. 

 

2.Use the Application Link icons to navigate to pages and dashboards to perform your day-to- 
day activities. 

 

3.Access the Navigator to access any additional applications that are not available in the 
application section on the home page 

 

4. Favourited list of quick actions to quickly perform some key tasks. 
 

 
Note: The exact appearance of your windows may vary depending on your personalization 
and roles that is assign to you. 

 
 
 

 

 
 

Figure 2: Personal Home Page 
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Navigator Home Watchlist 
Settings 

& Action 
 

 
 
 
 
 
 
 

Logo Favorites & recent item Notification 
 

 
 

Figure 3: Navigation tools in the global area of the home page 
 

 
Once you have set your homepage as the Newsfeed Home Page, then it will come with 
different sections. 

 

 
1.  Apps Section. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click this to 
personalize 
springboard 

 
 

Figure 4: Apps section 
 

 
Within the Apps section, you have various icons that can be used to start navigating into 
the different work areas of an application. For example, if you would like to navigate to the 
Purchase Requisitions work area within Procurement, you will select your application as 
Procurement. And you will choose Purchase Requisition in the Apps section. When you 
select Purchase Requisitions, the system takes you to the Purchase Requisitions work 
area, where you can perform various activities, such as create and manage requisitions 
(catalog or non-catalog), monitor requisition status and history, etc. Once your work has 
been completed, you can go back to the home page by using the home icon. 
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You can also access the apps via the Navigator. 

 

Here, the access is granted to various work areas based on the roles that have been given 
to your user account. You have the flexibility to personalize the App section. You can 
decide what you want to show within these springboard icons and what you want to hide. 
If you are an order regular visitor to the Payment work area, you mostly work with 
Payable’s dashboard invoices, you can hide the payments by clicking on this icon. So, it 
will not be shown in the apps icon but only accessible through the Navigator. 

 
 
 
 
 
 

2.  Things to Finish section. 
 

 

Figure 5: Things to Finish section 
 

 
The Things to Finish section provides you with a count of any pending notifications that are 
assigned to you and may require an action from you. Account Link name created by me lists 
the approval requests that you have created. You can click the link to navigate to a full list of 
notifications pertaining to that account. Then the items listed in the Things to Finish section 
are same as the notifications that are listed in the global header. 

 

The same information is available when you click on notifications icon. You can access the 
same number of notifications from here, as well as from the Things to Finish section. The list 
displays the latest notification first and allows you to scroll horizontally to view more 
notifications. 

 

You can clear a notification from the list by clicking the Close icon. When you clear a 
notification, the count does not change, since no action is taken on that notification. If you click 
on you will get a listing of all the notifications that are either FYI or the notifications that require 
an action from you. When you click on the link it opens the notification, and you can get the 
details of the notification. If you are satisfied, you can either approve it or you can either reject 
it. Once the notification is read then the count will change. 
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3.  Analytics section 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click on this icon to either hide 
or display a particular infolet. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Infolets 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6: Analytics section 

 

 
As far as procurement is concerned, there are currently few choices of analytics 
display. And they are source to settle infolet, service infolet, innovate to commercialize 
infolet, plan to produce and order to cash infolets. You can personalize the Analytics 
section and decide which infolet should be visible, which should not be visible. 
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1.3   Creating Favorites and Setting Preferences 

 

 
Creating Favorites 

 

Each user has their own favorites and adding favorites is easy in cloud: just go to your favorite 
work area or task page. Click on the favorite icon and click Add to Favorites.  By this you get 
to your favorite pages directly and easily when you click the favorite icon. You can remove 
unwanted pages by clicking Manage Favorites. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7: Creating and Managing Favorites 

 

 
Set Preferences 

 

Select Preferences to set personal options such as regional, language, accessibility setting, 
watchlist, etc as shown in the list in Figure 8. You can also reset your password from the 
Preferences page. To get into set preferences, click on setting and action dropdown menu 
click on Set Preferences. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8: Setting Preferences 
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1.4  Overview of Using Work Areas to Streamline Business Processes 

 

 
Use work areas to gain instant insight into your business and identify potential problems with 
processing transactions. 

 

Work areas can include the following: 
 
 

• Infolets 

• Content area 

• Action toolbar 

• Tasks panel tab 

• Process Warnings and Errors 

• Bank Statement Reconciliation 

• Process Monitor 
 

 
 
 
 

Task Panel 
 
 
 
 
 
 

Content area 
 
 
 
 

Figure 9: Budgetary Control Work Area 
 
 
 
 
 
 

Infotiles 
 

Summarize a high volume of transactional information. You can quickly identify potential 
problems and prioritize your daily activities by scanning the infotiles and accessing transaction 
details. 

 

For example, select an infotile to display corresponding transactional information in the content 
area. You can also click links in the infotile to filter the records in greater detail in the content 
area. 

 

 
Content Area 

 

The content area displays transactional information related to the infotile you select. You can 
review the detailed information and take the necessary action. 

 

For example, click the item link in the table to drill down to transaction -level information. You 
can perform multiple actions on the transaction, such as editing, approving, or rejecting the 
transaction, and posting the transaction to the ledger. 
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Actions Toolbar 

 

Use the actions toolbar to perform a range of activities on one or more rows you select in the 
content area. 

 

For example, select a transaction row and use the View menu to view the transaction in more 
detail. You can export the data to an Excel worksheet, detach the pane, approve, or reject one 
or more transactions, as well as apply additional filters. 

 

 
Tasks Panel Tab 

 

The Tasks panel includes tasks that are related to the work area and that you have access to 
perform. 

 

For example, create an invoice, review journal entries, create mass additions, and manage 
accounting periods within a task panel. 

 

 
Process Warnings and Errors 

 

The process warnings and errors keep previous processes history that has been run for bank 
statement loader. This area contains purge function which is available to delete error files. 

 

For example, select on the file then click on  button to purge and completely terminate the 
files. 

 

 
Bank Statement Reconciliation 

 

The bank statement reconciliation will provide an information of bank statement and its status 
on reconciliation. There will be two tabs which are Incomplete and Complete. 

 

For example, Incomplete tab listed all bank statement that consists of statement lines which 
have not yet to reconcile while Complete tab listed bank statement which have been 
completed reconciled. 

 

 
Process Monitor 

 

The Process Monitor is to monitor schedule process. 
 

For example, instead of navigating to Scheduled Processes Task, you may use the refresh 
button to keep update on the process item.  It will provide you the same info as in Scheduled 
Processes Page. 
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1.5 Scheduled process 

 

 
Scheduled processes do tasks that are too complex or time-consuming to do manually, for 
example importing data or updating many records. You can run scheduled processes on a 
recurring schedule and send notifications based on how the process ends. Some scheduled 
processes give you printable output. Those processes might have Report in their name. 

 

 
Jobs 

 

Each scheduled process that you run is based on a job. The job is the executable that controls 
what the process can do and what parameters and other options you have for the process. A 
job set contains multiple jobs. 

 

Job definitions can be set on Oracle Business Intelligence Publisher reports so that people 
can run the reports as scheduled processes. 

 

 
Process Sets 

 

A process set is a scheduled process that is based on a job set. So, when you submit a 
process set, you are running more than one job. 

 

 
Note: When you submit certain scheduled processes, the job logic causes other processes to 
automatically run. But in this case, you are not submitting a process set that includes those 
other processes. 

 

 
Submission 

 

When you submit a scheduled process, you can use its parameters to control which records 
are processed and how. Some scheduled processes do not have parameters. 

 

As part of the submission, you can also set up a schedule for the process, for example to run 
once a week for two months. Every time a process runs, there is a unique process ID. 

 

 
Output 

 

Some scheduled processes provide output in PDF, HTML, and other formats. For example, a 
process can import records and produce output with details about those records. There are 
many types of output, for example a tax document or a list of transactions. 

 
 
 

 
Process Sets 

 

A process set is a type of scheduled process that is based on a job set and contains at least 
two processes. So, you can run many processes in one go, for a specific purpose. These 
processes run in a certain order, in serial or parallel, or by some other logic. 

 

Process sets can have any number of individual scheduled processes and even other process 
sets. 
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To Submit Scheduled Processes 

 

 
Click Navigator > Tools > Scheduled Processes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1.  On the Scheduled Processes Overview page, click Schedule New Process. 

2.  Leave the type as Job, enter the process that you want to submit, and click OK. 

3.  In the Process Details dialog box, enter at least the required parameters, if any. 
 
 

Some processes have no parameters at all. Some parameters depend on other 

parameters. For example, date range parameters might appear only after you select 

By Date for another parameter. 
 
 

4.  Click the Advanced button if you want to define the schedule, notifications, or output. 

Continue to the next steps. Or just skip to the steps for 

5.  Click Submit, to run the process once as soon as possible with the default output. 
 

 
 

Define the Schedule 
 

Set up a schedule to run the process on a recurring basis or at a specific time. Use the Process 
Details dialog box in Advanced mode. 

 
 

1.  Open the Schedule tab and select Using a schedule for the Run option. 

2.  Select a frequency. 

3.  Select User-Defined if you want to enter the exact dates and times to run the process. 

4.  You can select Use a Saved Schedule to use an existing schedule if there are any. 

5.  Depending on the frequency, define when the process should run. 
 
 

Define the Output 
 

You can choose the layout, format, and destination for your output. Use the Process Details 
dialog box in Advanced mode. 

 
 

1.  Open the Output tab, if available. 

2.  Click Add Output Document. 
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3.  Change the name if you want. The name identifies this output document when you go 

to view output later. 

4.  Select a layout if you have more than one to choose from. 

5.  Select a format, for example one of these: 
 
 

PDF: Is the best option if you want to print the output. 

Excel: Supports embedded images, such as charts and logos, but can be opened only 

in Excel 2003 or higher. 

Data: Gives you report data in an XML file, which is used mainly for editing the report 

layout. 
 
 

6.  Click Add Destination to send the output somewhere, for example to a printer or email 

address. You can add many destinations and send the output to all of them at the same 

time. 
 
 

Tip: You can also print the output as part of the steps for finishing the submission, 

instead of adding a printer destination here. 

 
To add more output documents, repeat steps 2 to 6. 

 

 
 

Set Up Notifications 
 

You can have notifications sent out depending on how the process ends. Use the Process 
Details dialog box in Advanced mode to set that up. 

 
 

1.  Open the Notification tab. 

2.  Click Create Notification. 

3.  In the Recipient field, enter the user ID of the person you want to send the notification 

to. 

4.  In the Condition list, select when to send the notification, for example when the process 

ends in error. 

5.  Click OK. 
 

 
 

To send notifications to more people, repeat steps 2 to 5. 
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Finish the Submission 

 

Follow these steps in the Process Details dialog box: 
 
 

1.  Click the Process Options button if you want to define settings that affect the data to 

be processed. 

2.  If the process gives you output and you want to print it, select the Print output check 

box and a printer. 

3.  Select the Notify me when this process ends check box if you want to get an email 

notification. 

4.  Enter submission notes to capture any information you want to associate with this 

submission. You can use your notes to find this submission later. 

5.  Click Submit. 

6.  Click OK to confirm. 
 

 
 

Tip: Note down the process ID for your submission so you can easily find it later. For example, 
let's say you set the process to run once a week. If you later want to cancel all runs on this 
schedule, you need to cancel this original submission with this process ID. 

 

 
To Submit Process Sets 

 

 
To submit a process set from the Scheduled Processes Overview page: 

 
 

1.  Proceed with the steps that you would follow to submit any scheduled process, but 

select Job Set for the Type option. 

2.  In the Process details dialog box, set parameters for individual processes in the set. A 

process set itself does not have parameters. 

a.  Select a process on the Processes tab. 

b.  Enter parameters for that process, if any. 

c.   Repeat for other processes in the set. 

3.  Define the schedule, output, and notifications for the process set, as you would do for 

any scheduled process. 

4.  Set any other options and click Submit. 
 

 
 

To Check Status 
 

 
1.  Click Navigator > Tools > Scheduled Processes. 

 

The Search Results table shows processes that match the default saved search, Last 
24 hours. 

• The table might be blank if nothing was submitted. 
 

• If submission notes were entered when submitting the process, you can use 
the Submission Notes column to help identify the process. 
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2.  If you don't see the process, click the Refresh icon or use the Search section. 

3.  Do any of these tasks to check on the progress of the process: 
 

• For more details about the status, click the status link. For example, if a process is 

in the Ready status, you can click the Ready link in the Status column to see 

where the process is in the submission queue. 

• Check the Start Time column to see if the process has started running yet. 

• In the Search Results table, find the This Job's Items Processed / Errors / 

Total column. For some scheduled processes, this column shows what's getting 

processed and how things are going. 

• Click the View Log button, especially if your process has a blank This Job's Items 

Processed / Errors / Total column. The type of information in the log varies, 

depending on the process. You can open the log from here only if the process is 

currently running. When the process is done, you might want to also take a look at 

the final log, if any, from the Details section. 
 
 
 

 
To view output from scheduled process 

 

 
1.  Click Navigator > Tools > Scheduled Process. 

2.  Find your scheduled process and, if you need to, refresh the search results to see the 
latest status. 

3.  Select the scheduled process. 

4.  Go to the Output subsection in the Details section. 
 

5.  Click the link in the Output Name column to view or download the output, which you 
can then print. 

6.  To view or export the output in a different format: 
 

a.  Click the Republish button. 

b.  Click the Actions icon. 

c.   Select Export, and then select a format. 
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2   UTILIZATION OF BUDGET ENTRIES 

*Since 2024, LSE is practising Budget for all Department and Project. 
 

This section will provide more understanding on the budget utilization upon purchase 
document. In Oracle applications, budget utilization will be called as encumbrance accounting. 

 

There will be 3 types of encumbrances accounting: Commitments, Obligations, and 
Expenditures (Actual). Below will be highlight more on the event and how the encumbrance 
involves in every purchasing document. 

 

 
1) Event - Requisitions (Submission) 

 
Accounting Entries - 

(Commitment) DR – Charge Account 

CR – Reserve for Encumbrance 
 

 
Sample: 

Requisitions for Project budget for LSE108 – TANJUNG KELAS budget, requisition amount = 

RM 40,000.00 

 
Project Code Commitment Obligation Expenditure 

LSE108 40,000   
 
 

2) Event – Sourcing 
 

 
Accounting Entries – no encumbrance involves during sourcing 

 

 
3) Event – Purchase Order (Standard Purchase Order) 

 

 
Accounting Entries - 

 

(Commitment) DR – Reserve for Encumbrance 
 

CR –Charge Account 
 

Sample: 
 

Requisitions for Project budget for LSE108 – TANJUNG KELAS budget, requisition amount = 
RM 40,000.00. 

 

PO amount to be issue = RM 45,000 
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Event 
 

Commitment 
 

Obligation 
 

Expenditure 

 

Requisition 
 

40,000 
  

 

PO 
 

-40,000 
 

45,000 
 

 

GRN (receiving) 
  

-10,000 
 

10,000 

 

Total 
 

0 
 

35,000 
 

10,000 

 

 
 
 

Project Code = LSE108 
 

 

Event 
 

Commitment 
 

Obligation 
 

Expenditure 

 

Requisition 
 

40,000 
  

 

PO 
 

-40,000 
 

45,000 
 

 

Total 
 

0 
 

45,000 
 

 
 

4) Event – Good Receive Notes 
 

 
Accounting Entries – 

 

(Obligation) DR – Reserve for Encumbrance 
 

CR –Charge Account 
 

 
(Expenditure) DR – Charge Account 

 

CR – Reserve for Encumbrance 
 

Sample: 
 

Requisitions for Project budget for LSE108 – TANJUNG KELAS budget, requisition amount = 
RM 40,000.00. 

 

PO amount to be issue = RM 45,000. 
 

Receipt creation only partial = few quantities with RM10,000 total price. 

Project Code = LSE108 
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5) Event – Blanket Purchase Agreement/ Contract Purchase Agreement 
 

 
Accounting Entries – no encumbrance involves during document creation 

 

 
Why? During document creation, there are no account distribution created to validate 

the fund checking 
 

 
Sample of creation BPA: 

 

BPA agreed amount RM150,000.00 for item 09/01/00123 – Seal Tape 
 

No account available, and no project/department charge to this document. 
 

 
6) Event – Purchase Order (attached to BPA & CPA) 

 

 
Accounting Entries - 

 

(Obligation) DR – Charge Account 
 

CR – Reserve for Encumbrance 
 

 
Sample: 

 

PO amount to be issue = RM 15,000 for item 09/01/00123 – Seal Tape consume Project 
budget = LSE108. 

 

 
Project Code = LSE108 

 
 

Event 
 

Commitment 
 

Obligation 
 

Expenditure 

 

PO 
  

15,000 
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Event 
 

Commitment 
 

Obligation 
 

Expenditure 

 

PO 
  

15,000 
 

 

GRN (receiving) 
  

-15,000 
 

15,000 

 

Total 
 

 

0 
 

15,000 

 

 

7) Event – Good Receive Notes 
 

 
Accounting Entries – 

 

(Obligation) DR – Reserve for Encumbrance 
 

CR –Charge Account 
 

 
(Expenditure) DR – Charge Account 

 

CR – Reserve for Encumbrance 
 

 
Sample: 

 

PO amount to be issue = RM 15,000 for item 09/01/00123 – Seal Tape consume Project 
budget = LSE108. 

 

Receipt creation only partial = few quantities with RM15,000 total price. 

Project Code = LSE108 



User Manual 

Responsive Self Service Procurement Module v1.0 Olivestouch Technologies Sdn Bhd 

Confidential Page 20 of 71 

 

 

 

 

3 REQUISITION PREFERENCES 
 

 
To make the requisition creation efficient, Oracle has provided the Preference functionality 
where requestor can manage frequently on the default values when creating purchase 
requisitions.  

 
 

 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Procurement 
 

Procurement > Purchase Requisitions (New) 

 

Table 1: Navigation 
 
 
 

 

 
 

 
Figure 1: Procurement Work Area 

 

 
This is the front page of the Self-Service Procurement Module: 

 

 
 

Figure 2: Self Service Procurement Front Page 
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No. 
 

Steps 

 

1. 
 

Click on More Tasks 

 

2. 
 

Choose the “Preferences” 

 

3. 
 

Requisitioning BU 
 

LSE BU *Autogenerated 

 

4. 
 

Enter Details Shipping and Delivery 

 

5. 
 

Requester 
 

Enter requester 

 

6. 
 

Deliver-to-Location 
 

a) Labuan Shipyard & Engineering Sdn Bhd 
 

(for non-warehouse item / direct to HQ) ->Item Services 

b) Labuan Shipyard & Engineering W01  

c) Labuan Shipyard & Engineering W02 

d) Labuan Shipyard & Engineering W03 

 

 
 

One specific delivery to location for project site. 

Ex: Labuan Shipyard & Engineering Project 

This is for purchasing project item, but the expected delivery 
point (receiving point) is directly to the client site/ project site, 
which usually happened at KK site. 

 

7. 
 

Destination Type 
 

Expense / Inventory 

 

 

 

3.1 Create Requisition Preferences 

 
 *kalau tidak set preferences, the Catalog will not be appearing. 
 

This process is to be setting up preferences for ease of purchase requisition process. 
 

 

 
 

Figure 3: Update Requisition Preferences 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*Asset *stock 
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  - If Inventory, please specify sub inventory. 

 

8. 
 

Under the Favorite Charge Accounts click the Add Row button. The ‘+’ icon represents 
adding a row. *Optional 

 

Table 2: Update Requisition Preferences 
 

 

 

Figure 4: Enter Requisition Preferences for Expense 
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Figure 5: Enter Requisition Preferences for Inventory 
 

 

*mesti assign Preferences so that we can see Catalog and available Inventory Items. Kalau tiada 

“Delivery To Location” , you will not see the Items lists.
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4 CATALOG PURCHASE REQUISITION 

*This catalog is maintain by Warehouse, is the list of all available items. 
 

A pre-defined list of items. Requester can create purchase requisition using catalog. 
 

 
 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Procurement 
 

Procurement > Purchase Requisition (New) 

 

Table 3: Navigation 
 
 
 

 

 
 

Figure 6: Procurement Work Area 
 

 

*Notes: Hardcopy MRV is still needed but it is under own Department only, as a reference 

to PR PIC to enter into system. This MRV must be attached to PR in system. Hardcopy 

MRV no need to be signed, as the approval will be done in system. Approval Matrix is: 

1) Material Purchase(Project and Non-Project) - Level 1 (HOD) -> Level 2 (WH Manager) 

2) Services/SR (Project and non-project) - Level 1 (HOD) -> Level 2 (COO) 

3) Asset - Level 1 (HOD) -> Level 2 (Finance Manager) 
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4.1 Search Catalog Category 
 
 
 

 

 
 

Figure 7: Sample item category to be delivered to W01 
 

 

 
 

Figure 8: Search Item in Category 
 

 

*Item yang belum ada dalam catalog, have to request WH to enter@create. 
 
*Important! 

Do not create PR using the "Non-Catalog" option.LSE punya SOP, 

semua PR@pembelian MUST have item code. If you use non-catalog, 

your PR tiada Item Code and it will not be recorded in inventory! 
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No. 
 

Steps 

 

1. 
 

Click any preferred category for the item. 

 

2. 
 

Click view details 

 

3. 
 

Specify quantity. Click Add To Cart. 
 
 
 
 
 
 
 
 

*price is just estimation, 

not the real price. Buyer 

will change after quotation. 

 
 
 
 

 
Users need to check on the category during check out as system cannot control category 

for one PR number. 

 

4. 
 

Click view cart 

 

Table 4: Add To Cart 
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4.2 Edit Requisition Page 

 

 

 
 
 
 
 
 
 
 
 
 

*what you write here will appear in PO later on.So, please write useful info 

related to the PR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9: Edit Requisition Screen 
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No. 
 

Steps 
 

Detail 

 

1. 
 

Enter detail of the Purchase Requisition Header 

 

2. 
 

Description* 
 

Enter Description 

 

3. 
 

Justification 
(If any) 

 

Enter Justification 

 

4. 
 

PR 
Additional 
Information 

 

(To choose 
budget 
defined 
either by 
‘Department’ 
or ‘Project) 

 

Choose ‘LSE DFF’  *for budget. 
 
 
 
 
a ) Purchase involves Department Budget 

 
 
 
 
 

*mesti pilih ini,if not means your PR tiada bajet.or 

your PR will not be reflected in Budget later on. 
 
 
 
 
 
 

Info: Requester needs to choose ‘General & Admin’ range at Requisition 
Cost Centre which has available funds to ensure the budget consumed at 
Department level. 

Refer Appendix 1 – For Charge Account and Item combination. Get 

the right Charge Account, otherwise Approval will also wrong! 
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b) Purchase involves Project 

Cost Center for Department: 

81160=HRA 

81190=CCD 

81210=FINANCE 

81230=IT 

81250=COMMERCIAL 

81300=PROCUREMENT 

85170=SECURITY 

85601=PROJECT 

85630=QHSE 

85760=ENGINEERING 

85770=PRODUCTION 

85790=QC 

85810=WH 

85840=MAINTENANCE & FACILITY 

Cost Center related to Project: 

82510 = Ship Building.Project with LSExxx 

83640 = O&G. Project with Gxxx 

84910 = Ship Repair. Project with MExx and 

RSxx 
 
 

*for Department,enter the Cost Ctr 
as per your Dept.  

*for Project, compulsory to enter. Enter 00000 if no Project. 
 

 
 

Info: 
 

Requester must select a cost center that is NOT within the ‘General & Admin’ 
range and ‘Construction Overhead’ range. 
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Click Update 

 

5. 
 

Enter details of Requisition Lines. 

 

6. 
 

Quantity 
 

Enter Quantity 

 

7. 
 

Enter Line: Details 

 
Please specify the line item description. This is needed for procurement during the sourcing 

process to ensure more detailed purchase specifications. 
 
 
 
 
 
 
 
 
 
 

*sini boleh isi more explanation about the item, but don't delete the original item 

description.Tulis dibawah Line Description. 

 

8. 
 

Delivery 
 

 
Click icon 
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*Important!Jangan salah pilih Destination Ty 

Inventory=material @ stock. 

Expenses=Service,Asset dan non-inventory 

items. 

Kalau salah pilih, akan effect kepada 

charging account di Finance dan Inventory 

  Record!  

 

9. 
 

Urgent 
 

No 
 

 
*Yes. If intends to create PR directly to PO without sourcing. 

 

10. 
 

Requested 
Delivery 
Date* 

 

Autogenerated but can amend as per user preference. 

 

11. 
 

Deliver- to- 
Location 

 

 
* 

 

a) Labuan Shipyard & Engineering Sdn Bhd (for non-warehouse item) 
 

b) Labuan Shipyard & Engineering W01 

c) Labuan Shipyard & Engineering W02 

d) Labuan Shipyard & Engineering W03 

 

12. 
 

Deliver-to- 
Address 

 

Autogenerated once select Deliver-to-Location 

 

13. 
 

Destination 
Type 

 

Expense / Inventory 
 

-If inventory, please specify sub inventory. 

 

14. 
 

Billing 

 

15. 
 

Charge 
Account 

 

Autogenerated. Once the user has specified both Requisition Cost Center and 
Project, click Save. 

 

 
 
 
 
 
 
 
 
 
 

pe. 
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16. 
 

Budget Date 
 

Autogenerated but can amend as per user preference. 
 
 
 
 
 
 
 
 
 

*double check the GL and project code, 

sama dengan yg di Page 29. Refer 

Charge Account in Appendix 1. 

 

17. 
 

Percentage 
 

100 *If not 100, system will prompt error 

 

18. 
 

Quantity and 
Amount 
(MYR) 

 

Autogenerated. 

 

19. 
 

Notes and Attachments 
 

User able to attach attachment at header and line level 
*attached the hardcopy MRV from requestor. 

For purchases that require MRV such as for production, maintenance and petty cash, the 
MRV must be attached at the time of PR creation. 

 

20. 
 

Insert Note to Supplier (If any) 

 

21. 
 

Click Attachments None + (If any) 
 

 
 
 
 
 
 

*no size limit to attachment 
 
 
 
 
 
 

 
Click Update 
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22. 
 

Click Actions and Check Funds to review if fund is sufficient or not. 

 

23. 
 

Click View details 

 

24. 
 

Go to Transactions Line 
 

 
*User must select ‘All’ to ensure budget is controlled by either Department level or Project. 

Fund check at Department budget 
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Fund check at Project budget level 

 

 

*To Check for Budget details: 

1) Click “Check Fund” 

 
 

 

 

 

 

 

 

 

 

 



User Manual 

Responsive Self Service Procurement Module v1.0 Olivestouch Technologies Sdn Bhd 

Confidential Page 35 of 71 

 

 

 

 

 
 

Budget shows by overall total. 
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Info: Please make sure ONLY ONE Budget control is applied for the requisition. 

 

25. 
 

Click View Approvers to view the approval flow. 
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26. 
 

Click Submit 
 

*Before you submit what's in your Cart, please double check the Items in the Cart. Since 

we are sharing User ID(per department), other users might had added items to the cart, 

which supposedly for different PR. 

Please communicate with each other(in same department) before submitting any PR for 

approval, supaya Items org lain tidak ter masuk dalam your PR. 
 
 

Table 5: Edit Requisition for Catalog Purchase 

*If PR suda created, but not submitted for Approval yet, you still can edit the PR Lines. 

Delete the items that are not yours, but need to inform the other PR PIC to add in the Cart. 
 
 

*PR that is submitted for Approval. 

For Inventory@Material: 

Approver Level 1 - HOD 

Approver Level 2 - HOD Warehouse. -> If stock available, PR will be Rejected and WH 

will issue SIV, and notify Requestor. 

For Services: 

Approver Level 1 - HOD 

Approver Level 2 - COO 

For Assets: 

Approver Level 1 - HOD 

Approver Level 2 - HOD Finance 
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5 ENTER REQUISITION LINE 
 

Use enters requisition line to create purchase requisition with item code and to amend the 
price of the purchase. User may create ‘PR with Preferred Supplier’ by using this feature as 
well. *Notes: at catalog cannot amend the price. 

 
 

 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Procurement 
 

Procurement > Purchase Requisition (New) 

 

Table 6: Navigation 
 
 
 

 

 
 

Figure 10: Procurement Work Area 
 

 
 
 
 
 
 
 
 
 
 

*click this 
 
 
 
 
 

Figure 11: Enter Requisition Line 
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Figure 12: Enter Requisition Line Screen 
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5.1 PR with Preferred Supplier 

 

 
 

No. 
 

Steps 
 

Detail 

 

1. 
 

Enter Requisition Line Page 

 

2. 
 

Item 
 

Search item from list of values. *Please input item code. Even Services 
also considered as ‘item’ since it has ‘item code’. 

 

3. 
 

Item Description* 
 

Item Description will populate automatically referring to the setup in 
item master. 

 

4. 
 

Line Type* 
 

Select Goods 

 

5. 
 

Category Name* 
 

Autogenerated once item has been selected 

 

6. 
 

Quantity* 
 

Enter Quantity 

 

7. 
 

UOM Name* 
 

Enter UOM 

 

8. 
 

Price* 
 

Enter Preferred Price 

 

9. 
 

Currency* 
 

MYR 

 

10. 
 

Source Details 

 

11. 
 

Agreement Type 
 

Autogenerated 
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12. Agreement *Optional 
 

13. Supplier Specify preferred registered supplier 
 

14. Review the detail on the Delivery 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
15. Requester* Enter Requester 

 

16. Urgent No 
 

17. Requested Delivery 
Date* 

Input any date for the item to be delivered 

 

18. Deliver-to-Location*     Labuan  Shipyard  &  Engineering  Sdn  Bhd  /  Labuan  Shipyard  & 
Engineering W01 / Labuan Shipyard & Engineering W02 / Labuan 
Shipyard & Engineering W03 

 

19. Deliver-to -Address Autogenerated once ‘Deliver-to-Location’ has been specified 
 

20. Destination Type Inventory / Expense (Service / Asset) *Jangan salah pilih! 
 

- If ‘Inventory’, please specify Sub inventory. 
 

 

21. Review the detail on the billing 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

22. 
 

Charge Account 
 

Autogenerated but it can be change after click ‘Add to Cart’ button 

 

23. 
 

Budget Date* 
 

Autogenerated to the date you are creating the PR. 

 

24. 
 

Percentage* 
 

100 
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25. 
 

Amount (MYR) 
 

Autogenerated 

 

26. 
 

Review Notes and Attachments 

 

27. 
 

Insert Note to Supplier (If any) 

 

28. 
 

Click Attachments None + (If any) 

 

29. 
 

Click Create and Continue 

 

30. 
 

Click Check Funds to review if fund is sufficient or not. 

 

31. 
 

Click View details 
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32. 
 

Click View Approvers 
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33. 
 

Click Submit Button 

 

Table 7: Edit Requisition for Enter Requisition Line 
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6 MANAGE REQUISITIONS 
 

 
User able to use ‘Manage Requisition’ feature to view PR created so far. 

 

 
 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Procurement 
 

Purchase Requisitions (New) > My Requisitions > Search 

 

Table 8: Navigation 
 
 
 

 
 

No. 
 

Steps 

 

1. 
 

Click My Requisitions 

 

2. 
 

Filter your search 



User Manual 

Responsive Self Service Procurement Module v1.0 Olivestouch Technologies Sdn Bhd 

Confidential Page 46 of 71 

 

 

 
 

3.  
 
 
 

Table 9: Manage Requisition 
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7 CANCEL PURCHASE REQUISITION 
*PR with RFQ and PO cannot cancel. If still want to cancel, kena cancel RFQ/PO duluan. 

 
Users can cancel the entire requisition if it has not already been included in a purchase order. 
Oracle Purchasing creates negative debit encumbrance entries for cancelled requisitions and 
immediately updates funds available when you cancel a requisition or part of a requisition. 

 
 

PR Status 
 

Ability to Cancel PR 

 

Incomplete 
 

 

Approved 
 

No PO: 
 

PO Available: 

 

Pending 
Approval 

 

 

Withdrawn 
 

 

Returned 
 

 

Table 10: Status of PR that can be cancel 

 
 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Procurement 
 

Purchase Requisitions (New) > My Requisitions > Search PR 
Number 

 

Table 11: Navigation 
 

 

No. 
 

Steps 

 

1. 
 

Click on Cancel. 
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2.  
 

Table 12: Cancel Purchase Requisition 
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8 EDIT PURCHASE REQUISITION FUNCTION 

 

 
 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Procurement 
 

Purchase Requisitions (New) > My Requisitions > Query PR 
Number 

 
 

Table 13: Navigation 
 

 

 
 

Figure 13: Navigate to Manage Requisitions 
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No. 
 

Steps 

 

1. 
 

Click on Edit 

 

2. 
 

Click on Continue 

 

3. 
 

Edit the Purchase Requisition 
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Table 14: Edit Purchase Requisition 
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9   DUPLICATE PURCHASE REQUISITION 
 

 
Existing requisitions that are not in an incomplete status can be duplicated into a new 
requisition starting from the My Requisitions page. This allows all previous line detail to be 
carried into the new requisition. This reduces the amount of time to create requisitions for 
items that are ordered repeatedly. The new requisition details can be then edited accordingly 
before submission. 

 

 
 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Procurement 
 

Purchase Requisitions (New) > My Requisitions > Query PR 
Number 

 

Table 15: Navigation 
 
 
 
 
 
 

 

No. 
 

Steps 

 

1. 
 

Open PR Number. Go to Actions and Click on Duplicate. 

 

2. 
 

System will automatically create new PR number 
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Table 16: Duplicate Purchase Requisition 
 
 
 
 
 
 

10 PURCHASE REQUISITION APPROVAL 
 
 
 

10.1 Approve Via Notifications 
 

 
System able to deliver notification to notify approver to take action on purchase requisition. 

 

 
 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Notifications 
 

Notifications 

 

Table 17: Navigation 
 
 
 

 
Click the Notifications (Bell icon) at the top right of the page. 

 

 

 
 

Figure 15: Navigation 
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Figure 16: Approver Notification Page 
 
 
 

 
 

No. 
 

Steps 

 

1. 
 

Approver can review detail of the Purchase Requisition before approve the PR. Click PR link 
to view detail. 

 

2. 
 

Approver can add attachment (if necessary) 
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3. 
 

Click Approve or Reject the Purchase Requisition 

 

4. 
 

Click Submit Button 

 

 
Table 18: Approve Purchase Requisition 
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Approve Via Email 

 

 
 

 
 
 
 

 
Figure 17: Approver Email Page 

 

 
 

No. 
 

Steps 

 

1. 
 

Approver able to view the information of Purchase Requisition by clicking on ‘Requisition link’. 
 

Click Approve or Reject Button. 

 

2. 
 

Enter Comment if Any. 
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Click Send Button. 
 
 
 
 
 
 
 
 
 
 
 
 

 
*enter comments here before approving the PR. 

 
 
 
 
 
 
 
 
 
 
 

Table 19: Approve Via Email 
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10.2 On – Hands Balance Checking (For inventory only) 
*action by Warehouse team 

 

Approver L1 HOD 
 

Approver L2 WM: Stock Balance Checking 
 

If, 
 

• No Stock? Proceed approve the PR 

• Stock Available? Proceed reject PR & raise SIV. 
 
 

 
More details in ‘Oracle Procurement Cloud User Manual Inventory’. 

 
 
 

 
 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Supply Chain 
Execution 

 

Inventory Management 

 

Table 20: Navigation 
 

 

 
 

Figure 18: Supply Chain Execution Work Area 
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No. 
 

Steps 

 

1. 
 

Click Task. 
 

 
 
 
 
 
 
 
Change Show Tasks: Inventory. Click Manage Item Quantities. 

 

Table 21: On Hands Balance Checking for Approver L2 (Warehouse Manager) 
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11 RECEIVING GOOD / SERVICES (EXPENSE ITEM ONLY) 
 

• Should be done by Requester 

*Item of type Expense(include Service and Asset) will be Received by PR PIC in system. 

This is one of the reason, why you must be careful with the Destination Type explained earlier! 
All goods and services (For expense item only) must be received by requestor before process 
by Account Payable team. 

 

For inventory item, user Supply Chain Execution – Inventory Management – Task Panel 
– Show Task: Receipts. However, receiving goods for inventory item will be covered under 
‘Oracle Procurement Cloud User Manual Inventory’. 

 

 
 

No. 
 

Work Area 
 

Navigation 

 

2. 
 

Procurement 
 

My Receipts 
 

Table 22: Navigation 
 
 
 
 

 
 

Figure 19: Procurement Work Area 

judy.t
Highlight
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Receive Items in system is use for update receiving quantity. However, once user input 
complete total goods received (Full GRN), user will be unable to search that PO anymore. 

 

 
 

No. 
 

Steps 

 

1. 
 

The Receive page will display several field in the search section. Requester Name will be 
default as user name. User can search by multiple criteria. For this example, user can search 
by Items Due = Anytime, Requester, Purchase Order. 

 

 

 
 

If, 
 

Search by PO but not appear anything. Reason: PO is ‘pending approval’ 
 
 
 

PO must be approved before update receiving item. 

 

2. 
 

From the search Result, select the row of a requisition to receive against. 
 

 

 
 

 
 
To Select Multiple rows for creating receipt at once, enter ‘Shift’ and click those lines. 
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3. 
 

Click on Receive Button 

 

4. 
 

Click the Show Receipt Quantity button to show the quantity remaining to receive. 

 

5. 
 

Compared the displayed quantity to what will be received. If different from what displays in the 
Quantity field, enter the Quantity. 

 

 

 
 

 
 

a) Partial GRN – when user input only part of the total goods are received. 

b) Full GRN – when user input complete total of goods received. 

 

6. 
 

Attach Delivery Order/ Service Report/ Invoice (If Any). 
 

 
Please ensure to follow below step to display the attachment function. 

 

View > Columns > Click on Attachments 

judy.t
Cross-Out

judy.t
Typewritten Text
*For Service: Compulsory to attach Complete Report list, with signature from all relevant party.DON'T PERFORM RECEIVE WITHOUT THIS DOCUMENTS.
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7. 
 

Click Attachments Icon 
 

 

 
 

Choose File and Click OK Button 

 

8. 
 

Click Submit Button 
 

 
GRN Number will be display. 

 

 

 
 

 
 
Click OK button 



User Manual 

Responsive Self Service Procurement Module v1.0 Olivestouch Technologies Sdn Bhd 

Confidential Page 64 of 71 

 

 

 
 

9. To identify whether partial / full GRN created, search by specific PO. If, 
 

 
 

• Able to search - partial GRN created 

• Unable to search - either Full GRN has been created / Check PO existance & status 
 
 
 

Click View – Columns 
 

 

 
 
 
 

Table 23: Create Receipt 
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12 REASSIGN REQUISITION 

There is scenario where other department required to raise PR for project use. Therefore, the approver 
should be the Project Department HOD. To achieve this, use the Reassign Requisition. 

 

Cl ick the “Reassign ”  

 
 

This screen wi l l  appear.  Type in the “Reassign To ” .  I f  you Reassign to 
PR_MAINTENANCE, means HOD Maintenance wi l l  be the Approver.  

 
 

 

Notes:  

Reassign is  only enable after the PR is submitted. Therefore,  the 
original Approver wil l  get  the email  notif icat ion, but cannot approve.  
The new assign PR approver,  wil l  automatical ly get email  to approve 
the PR.  
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PR History af ter  Reassign Requisi t ion.  
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13 FREQUENCY ASKED QUESTION / SPECIFIC SCENARIOS 
 

13.1 Return Receipt (Administrator responsibilities) 
 

• Should be done by buyer 
 
 
 

 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Procurement 
 

My Receipt 
 

Table 24: Navigation 
 

 

 

Figure 20: Procurement Work Area 
 
 
 
 
 
 

 

No. 
 

Steps 

 

1. 
 

Click the Tasks icon and go to Manage Receipts 

 

2. 
 

Find the Receipt Number and Click Search button. 
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If unable to provide Receipt, Search by PO. 

 

3. 
 

User may click Receipt Link to verify the item quantity ordered and received. 

To view more details, Click View – Columns. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click Done to go back create Return Receipt. 

 

4. 
 

Select a row to be returned and Click on Return Button 
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To create multiple Return Receipts at once, enter ‘shift’ and select those lines. After that, click 
Return Button. 

 

5. 
 

Enter Return Quantity, Reason and RMA (Return Material Authorization -If any). 
 

 

 
 

 
 
Click Submit Button. 
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6. 
 

After click OK, note that the quantity will decrease. 

After Return: 

 

 
 
 
 
 
 
 
 
 
 
 
Before Return: 

 

Table 25: Return Receipt 
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13.2 Correct Receipt (Administrator responsibilities) 

 

• Should be done by buyer 
 
 
 

 

No. 
 

Work Area 
 

Navigation 

 

1. 
 

Procurement 
 

My Receipt 
 

Table 26: Navigation 
 
 
 

 
 

No. 
 

Steps 

 

1. 
 

Click the Tasks icon and go to Manage Receipts 

 

2. 
 

Find the Receipt Number / PO Number and Click Search button. 

 

3. 
 

Select a row to be returned and Click on Correct Button. 
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To select multiple rows, enter ‘Shift’ key and click on the selected row. 

 

4. 
 

Enter Correct Quantity 
 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click Submit Button 
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5. 
 

After click OK, note that the received quantity has change 
 

 
After Correct Receipt: 

 

Table 27: Correct Receipt 
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End of Document 



FOR ITEM TYPE ASSETS AND SERVICES

New Item Code Item Description Account
99/001 99/FA/001 BUILDING BUILDING 101100
99/002 99/FA/002 INFRASTRUCTURE/RENOVATION RENOVATION 101200
99/019 99/FA/019 6W 3 PHASE MAIN SWITCH 63A RENOVATION 101200
99/003 99/FA/003 MACHINERY & EQUIPMENT MACHINERY & EQUIPMENT 101400
99/015 99/FA/015 400KVA YRD FREQCY CONVERTER MACHINERY & EQUIPMENT 101400
99/033 99/FA/033 GENERATOR AVR.SX460 MACHINERY & EQUIPMENT 101400
99/061 99/FA/061 PORTABLE BLOWER FAN MACHINERY & EQUIPMENT 101400
99/062 99/FA/062 PORTABLE BLOWER FAN C/W DUCTIN MACHINERY & EQUIPMENT 101400
99/063 99/FA/063 PORTABLE DOUBLE EYEWASH MACHINERY & EQUIPMENT 101400
99/064 99/FA/064 PORTABLE EYEWASH STATION MACHINERY & EQUIPMENT 101400
99/065 99/FA/065 PORTABLE MIXER MACHINERY & EQUIPMENT 101400
99/079 99/FA/079 PORTABLE AIR COMPRESSOR DIESEL MACHINERY & EQUIPMENT 101400
99/080 99/FA/080 COMPRESSOR MACHINERY & EQUIPMENT 101400
99/081 99/FA/081 STIHL CHAINSAW MACHINERY & EQUIPMENT 101400
99/082 99/FA/082 STIHL GRASS CUTTING MACHINE MACHINERY & EQUIPMENT 101400
99/083 99/FA/083 STIHL HIGH PRESSURE PUMP MODEL MACHINERY & EQUIPMENT 101400
99/005 99/FA/005 BOATS MOTOR VEHICLE 101600
99/006 99/FA/006 MOTOR VEHICLE MOTOR VEHICLE 101600
99/009 99/FA/009 DESKTOP COMPUTER IT EQUIPMENT 101810
99/010 99/FA/010 NOTEBOOK/LAPTOP IT EQUIPMENT 101810
99/011 99/FA/011 COMPUTER SOFTWAR IT EQUIPMENT 101810
99/012 99/FA/012 COMPUTER MONITOR IT EQUIPMENT 101810
99/013 99/FA/013 IT INFRASTRUCTUR IT EQUIPMENT 101810

99/FA/014 TABLET COMPUTER IT EQUIPMENT 101810
99/FA/016 48PORT ETHERNET NETWORK SWITCH IT EQUIPMENT 101810
99/FA/017 4PORT POE GIGABIT SWITCH IT EQUIPMENT 101810
99/FA/018 500GB SATA 2.5" HDD IT EQUIPMENT 101810
99/FA/028 ETHERNET NETWORK SWITCH 24PORT IT EQUIPMENT 101810
99/FA/029 ETHERNET SWITCH 5PORTS IT EQUIPMENT 101810
99/FA/026 APC BACK-UPS 650VA IT EQUIPMENT 101810
99/FA/008 OFFICE EQUIPMENT OFFICE EQUIPMENT 101800
99/FA/020 AIR COMPRESSOR SA SERIES SA-6E OFFICE EQUIPMENT 101800
99/FA/021 AIR COND COMPRESSOR SD-508 SAN OFFICE EQUIPMENT 101800
99/FA/022 AIR CONDITIONER 1.0HP OFFICE EQUIPMENT 101800
99/FA/023 AIR CONDITIONER 1.5HP OFFICE EQUIPMENT 101800
99/FA/024 AIR CONDITIONER 2.5HP OFFICE EQUIPMENT 101800
99/FA/025 AIR CONDITIONER 2HP OFFICE EQUIPMENT 101800
99/FA/027 CEILING FAN OFFICE EQUIPMENT 101800
99/FA/030 FIRE ALARM BELL 24VDC OFFICE EQUIPMENT 101800
99/FA/031 FIRE ALARM CONTROL PANEL 12ZON OFFICE EQUIPMENT 101800
99/FA/032 FIRE ALARM CONTROL PANEL 6 ZON OFFICE EQUIPMENT 101800
99/FA/034 FIRE EXTINGUISHER  DRY POWDER 9L OFFICE EQUIPMENT 101800
99/FA/035 FIRE EXTINGUISHER 9KGS OFFICE EQUIPMENT 101800
99/FA/036 FIRE EXTINGUISHER CABINET OFFICE EQUIPMENT 101800
99/FA/037 FIRE EXTINGUISHER CO2 2.3KG OFFICE EQUIPMENT 101800
99/FA/038 FIRE EXTINGUISHER CO2 6.8KG OFFICE EQUIPMENT 101800
99/FA/039 FIRE EXTINGUISHER FOAM 45L+TROLLEY OFFICE EQUIPMENT 101800
99/FA/040 FIRE EXTINGUSHER D/POWDER 4KG OFFICE EQUIPMENT 101800
99/FA/041 FIRE EXTINGUSHER D/POWDER 6KG OFFICE EQUIPMENT 101800
99/FA/042 FIRE EXTINGUSHER INSPECT TAGS OFFICE EQUIPMENT 101800
99/FA/048 NOTICE BOARD  DANGER OFFICE EQUIPMENT 101800
99/FA/049 NOTICE BOARD 122CMX140CM OFFICE EQUIPMENT 101800
99/FA/050 NOTICE BOARD ADMITTANCE OFFICE EQUIPMENT 101800
99/FA/057 OFFIE PRINTER OFFICE EQUIPMENT 101800
99/FA/058 OIL TRAP OFFICE EQUIPMENT 101800
99/FA/059 OVEN OFFICE EQUIPMENT 101800
99/FA/060 PAPER SHREDDER OFFICE EQUIPMENT 101800
99/FA/066 PORTABLE PA SYSTEM WIRELESS OFFICE EQUIPMENT 101800
99/FA/067 PORTABLE PROJECTOR OFFICE EQUIPMENT 101800
99/FA/068 PROJECTOR OFFICE EQUIPMENT 101800
99/FA/069 PROJECTOR CEILING BRACKET OFFICE EQUIPMENT 101800
99/FA/070 SAFE BOX OFFICE EQUIPMENT 101800
99/FA/073 TELEPHONE KEYPHONE OFFICE EQUIPMENT 101800
99/FA/074 TELEPHONE SINGLE LINE OFFICE EQUIPMENT 101800
99/FA/078 WASH BASIN STONE OFFICE EQUIPMENT 101800
99/FA/007 FURNITURE AND FI FURNITURE & FITTINGS 101700
99/FA/004 LOOSE TOOLS FURNITURE & FITTINGS 101700
99/FA/043 KITCHEN CABINET  5' 1588 FURNITURE & FITTINGS 101700
99/FA/044 KITCHEN CABINET WALL MOUNTED FURNITURE & FITTINGS 101700
99/FA/045 LED TV FURNITURE & FITTINGS 101700
99/FA/046 MICROWAVE FURNITURE & FITTINGS 101700
99/FA/047 MINI FRIDGE FURNITURE & FITTINGS 101700
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99/FA/004 LOOSE TOOLS FURNITURE & FITTINGS 101700
99/FA/043 KITCHEN CABINET  5' 1588 FURNITURE & FITTINGS 101700
99/FA/044 KITCHEN CABINET WALL MOUNTED FURNITURE & FITTINGS 101700
99/FA/045 LED TV FURNITURE & FITTINGS 101700
99/FA/046 MICROWAVE FURNITURE & FITTINGS 101700
99/FA/047 MINI FRIDGE FURNITURE & FITTINGS 101700
99/FA/051 OFFICE  TABLE L1200X W600 H750 FURNITURE & FITTINGS 101700
99/FA/052 OFFICE CABINET FURNITURE & FITTINGS 101700
99/FA/053 OFFICE CHAIR FURNITURE & FITTINGS 101700
99/FA/054 OFFICE TABLE 5'X4' FURNITURE & FITTINGS 101700
99/FA/055 OFFICE TABLE 6'X3' FURNITURE & FITTINGS 101700
99/FA/056 OFFICE VACUUM CLEANER FURNITURE & FITTINGS 101700
99/FA/071 TABLE FURNITURE & FITTINGS 101700
99/FA/072 TABLE FAN 16" FURNITURE & FITTINGS 101700
99/FA/075 TV 50" FURNITURE & FITTINGS 101700
99/FA/076 WALL SHELF FURNITURE & FITTINGS 101700
99/FA/077 WARDROBE FURNITURE & FITTINGS 101700

NON-INVENTORY ITEM
ITEM CODE CHARGE CODE
77/001 77/001 77/001 STATIONERY 775500
77/002 77/002 77/002 NON INVENTORY 720100
09/04/00082 77/003 77/003  T-SHIRT 777501

ITEM TYPE SERVICE
OLD ITEM CODE CHARGE CODE
88/430 88/CERT/001 88/CERT/001 CERTIFICATION 770650
88/431 88/CERT/002 88/CERT/002 LSE CERTIFICATE OF FITNESS(CF) 773230

88/011 88/CLEAN/001 88/CLEAN/001 YARD CLEANING 777200
88/012 88/CLEAN/002 88/CLEAN/002 OFFICE CLEANING 773600

88/026 88/SRGF/001 88/SRGF/001 CUSTOM DUTY 774220
88/220 88/SRGF/002 88/SRGF/002 DOCKING EXPENSES 771500
88/310 88/SRGF/003 88/SRGF/003 FREIGHT CHARGES 772210
88/311 88/SRGF/004 88/SRGF/004 SERVICE CHARGE 772250
88/312 88/SRGF/005 88/SRGF/005 SERVICE CHARGE-CYLINDER 772251
88/320 88/SRGF/006 88/SRGF/006 CONSULTANT FEES 770810
88/350 88/SRGF/007 88/SRGF/007 LEGAL FEES 773110
88/370 88/SRGF/008 88/SRGF/008 PENALTY CHARGES 773810
88/313 88/SRGF/009 88/SRGF/009 ADDITIONAL CHARGE RATES 772260
88/300 88/SRGF/010 88/SRGF/010 CLASSIFICATION FEES 770600

88/013 88/SRGS/001 88/SRGS/001 CONTRACTOR FEES LSA & FFA 775750
88/015 88/SRGS/002 88/SRGS/002 PEST CONTROL & FUMIGATION 723101
88/016 88/SRGS/002 88/SRGS/002 SPOOLING SERVICES 723201
88/019 88/SRGS/003 88/SRGS/003 OVERHAUL & REWINDING SERVICES 723202
88/230 88/SRGS/004 88/SRGS/004 INSPECTION 772700
88/250 88/SRGS/005 88/SRGS/005 X-RAY & RADIOGRAPHY 777100
88/270 88/SRGS/006 88/SRGS/006 TRAINING 776200
88/290 88/SRGS/007 88/SRGS/007 ADVERTISING & PROMOTION 770100
88/380 88/SRGS/008 88/SRGS/008 PRINTING & PHOTOCOPIER MACHINE 774110
88/420 88/SRGS/009 88/SRGS/009 FOOD PROVISION SUPPLY 772220
88/432 88/SRGS/010 88/SRGS/010 ORACLE FUSION CLOUD 772230

88/2401 88/HIRE/001 88/HIRE/001 HIRE CHARGES-FORKLIFT 772410
88/2402 88/HIRE/002 88/HIRE/002 HIRE CHARGES-BULLDOZER 772411
88/2403 88/HIRE/002 88/HIRE/002 HIRE CHARGES-WHEEL LOADER 772412
88/2404 88/HIRE/003 88/HIRE/003 HIRE CHARGES-BREAKER 772413
88/2405 88/HIRE/004 88/HIRE/004 HIRE CHARGES-COMPACTOR 772414
88/2406 88/HIRE/005 88/HIRE/005 HIRE CHARGES-BACKHOE 772415
88/2407 88/HIRE/006 88/HIRE/006 HIRE CHARGES-EXCAVATOR 772416
88/2408 88/HIRE/007 88/HIRE/007 HIRE CHARGES-LOADOUT/SKID/AXLE 772417
88/2409 88/HIRE/008 88/HIRE/008 HIRE CHARGES-HYDROTEST EQUIPMENT 772418
88/241 88/HIRE/009 88/HIRE/009 HIRE CHARGES-CRANE 772401
88/2410 88/HIRE/010 88/HIRE/010 HIRE CHARGES-PUMPS 772419
88/2411 88/HIRE/011 88/HIRE/011 HIRE CHARGES-BOATS 772420
88/2412 88/HIRE/012 88/HIRE/012 HIRE CHARGES-AUXILIARY 772421
88/2413 88/HIRE/013 88/HIRE/013 HIRE CHARGES-CYLINDER 772422
88/2414 88/HIRE/014 88/HIRE/014 HIRE CHARGES-TANK 772423
88/2415 88/HIRE/015 88/HIRE/015 HIRE CHARGES-BLASTING & PAINTING EQUIPMENT 772424
88/2416 88/HIRE/016 88/HIRE/016 HIRE CHARGES-SKYLIFT 772425
88/2417 88/HIRE/025 88/HIRE/025 HIRE CHARGES-MECHANICAL EQUIPMENT 772426
88/242 88/HIRE/017 88/HIRE/017 HIRE CHARGES-TRAILER 772402
88/243 88/HIRE/018 88/HIRE/018 HIRE CHARGES-LOW BED 772403
88/244 88/HIRE/019 88/HIRE/019 HIRE CHARGES-LOAD BANK 772404

NEW ITEM CODE



88/245 88/HIRE/020 88/HIRE/020 HIRE CHARGES-GENERATOR 772405
88/246 88/HIRE/021 88/HIRE/021 HIRE CHARGES-COMPRESSOR 772406
88/247 88/HIRE/022 88/HIRE/022 HIRE CHARGES-TUG SERVICE & PILOTAGE 772407
88/248 88/HIRE/023 88/HIRE/023 HIRE CHARGES-CAR RENTAL 772408
88/249 88/HIRE/024 88/HIRE/024 HIRE CHARGES-LORRY 772409
88/240 88/HIRE/025 88/HIRE/025 HIRE CHARGES-GENERAL 772400

88/330 88/INS/001 88/INS/001 INSURANCE-PROJECTS 772810
88/340 88/INS/002 88/INS/002 INSURANCE-GENERAL 772910

88/001 88/MAINT/001 88/MAINT/001 MAINTENANCE OF BUILDING & INFRASTRUCTURE 723100
88/002 88/MAINT/002 88/MAINT/002 MAINTENANCE OF MACHINERY-GENERAL 723200
88/0021 88/MAINT/003 88/MAINT/003 MAINTENANCE OF MACHINERY-OH CRANE 723210
88/0022 88/MAINT/004 88/MAINT/004 MAINTENANCE OF MACHINERY-MT M4600 CRANE 723211
88/0023 88/MAINT/005 88/MAINT/005 MAINTENANCEOF MACHINERY-COMPRESSOR 723212
88/0024 88/MAINT/006 88/MAINT/006 MAINTENANCE OF MACHINERY-MT M250 CRANE 723213
88/0025 88/MAINT/007 88/MAINT/007 MAINTENANCE OF MACHINERY-BOOMLIFT 723214
88/003 88/MAINT/008 88/MAINT/008 MAINTENANCE OF MOTOR VEHICLE & BOAT 723300
88/004 88/MAINT/009 88/MAINT/009 MAINTENANCE OF FURNITURE & FITTINGS 723400
88/005 88/MAINT/010 88/MAINT/010 MAINTENANCE OF OFFICE EQUIPMENT 723500

88/211 88/SRPF/001 88/SRPF/001 PROFESSIONAL FEES-E&I 774201
88/212 88/SRPF/002 88/SRPF/002 PROFESSIONAL FEES-MECHANICAL 774202
88/213 88/SRPF/003 88/SRPF/003 PROFESSIONAL FEES-PIPING 774203
88/214 88/SRPF/004 88/SRPF/004 PROFESSIONAL FEES-EXTERNAL AUDIT 774204
88/215 88/SRPF/005 88/SRPF/005 PROFESSIONAL FEES-TESTING & COMMISIONING 774205
88/216 88/SRPF/006 88/SRPF/006 PROFESSIONAL FEES-PAINTING TEST 774206
88/217 88/SRPF/007 88/SRPF/007 PROFESSIONAL FEES-DIVER 774207
88/218 88/SRPF/008 88/SRPF/008 PROFESSIONAL FEES-DESLUDGING SERVICE 774208
88/210 88/SRPF/009 88/SRPF/009 PROFESSIONAL FEES-GENERAL 774200

88/260 88/SRRW/001 88/SRRW/001 WARRANTY REPAIR 776900
88/360 88/SRRW/002 88/SRRW/002 LICENSE & ANNUAL MAINTENANCE 773220

88/280 88/RENT/001 88/RENT/001 PROPERTY RENTAL 774310
88/2801 88/RENT/002 88/RENT/002 RENTAL CHARGE-CONTAINER 774311

88/027 88/REPAIR/009 88/REPAIR/009 REPAIR TOOLS 724600
88/006 88/REPAIR/001 88/REPAIR/001 REPAIR OF BUILDING AND INFRASTRUCTURE 724100
88/007 88/REPAIR/002 88/REPAIR/002 REPAIR OF MACHINERY 724200
88/008 88/REPAIR/003 88/REPAIR/003 REPAIR OF MOTOR VEHICLE & BOAT 724300
88/009 88/REPAIR/004 88/REPAIR/004 REPAIR OF FURNITURE & FITTING 724400
88/010 88/REPAIR/005 88/REPAIR/005 REPAIR OF OFFICE EQUIPMENT 724500
88/021 88/REPAIR/006 88/REPAIR/006 REPAIR OF MACHINERY-SKYLIFT 724201
88/022 88/REPAIR/007 88/REPAIR/007 REPAIR OF MOBILE CRANE 70T 724202
88/023 88/REPAIR/008 88/REPAIR/008 REPAIR OF MOBILE CRANE 460T 724203

88/2001 88/SUBCON/001 88/SUBCON/001 SUBCON FEES-HYDRAULIC 775708
88/2002 88/SUBCON/002 88/SUBCON/002 SUBCON FEES-AUTO & MONITORING SYSTEM 775709
88/2003 88/SUBCON/003 88/SUBCON/003 SUBCON FEES-NAVIGATION & COMMUNICATION 775710
88/2004 88/SUBCON/004 88/SUBCON/004 SUBCON FEES-MACHINING 775711
88/2005 88/SUBCON/005 88/SUBCON/005 SUBCON FEES-ARM & WEAPONRY SYSTEM 775712
88/2006 88/SUBCON/006 88/SUBCON/006 SUBCON FEES-SURFACE PREPARATION & PAINTING 775713
88/2007 88/SUBCON/007 88/SUBCON/007 SUBCON FEES-SCAFFOLDING 775714
88/2008 88/SUBCON/008 88/SUBCON/008 SUBCON FEES-WEIGHING 775715
88/2009 88/SUBCON/009 88/SUBCON/009 SUBCON FEES-UWILD/UNDERWATER 775716
88/201 88/SUBCON/010 88/SUBCON/010 SUBCONTRACTOR FEES-PIPING 775701
88/2010 88/SUBCON/011 88/SUBCON/011 SUBCON FEES-SEAFASTENING 775717
88/2011 88/SUBCON/012 88/SUBCON/012 SUBCON FEES-HYDROTEST 775718
88/2012 88/SUBCON/013 88/SUBCON/013 SUBCON FEES-INSPECTION & RECERTIFICATION 775719
88/2013 88/SUBCON/014 88/SUBCON/014 SUBCON FEES-SERVICE OF SEABOAT 775720
88/2014 88/SUBCON/015 88/SUBCON/015 SUBCON FEES-FUMIGATION & PEST CTRL 775723
88/2015 88/SUBCON/016 88/SUBCON/016 SUBCON FEES-CRADLE 775724
88/2016 88/SUBCON/017 88/SUBCON/017 SUBCON FEES-FABRICATION 775725
88/2017 88/SUBCON/018 88/SUBCON/018 SUBCON FEES-OVERHEAD CRANE 775726
88/2018 88/SUBCON/019 88/SUBCON/019 SUBCON FEES-SURVEY 775727
88/2019 88/SUBCON/028 88/SUBCON/028 SUBCON FEES-BLASTING 775728
88/202 88/SUBCON/020 88/SUBCON/020 SUBCONTRACTOR FEES-E&I 775702
88/203 88/SUBCON/021 88/SUBCON/021 SUBCONTRACTOR FEES-MECHANICAL 775703
88/204 88/SUBCON/022 88/SUBCON/022 SUBCON-HVAC & REFRIGERATION 775704
88/205 88/SUBCON/023 88/SUBCON/023 SUBCON FEES-ARCHITECTURAL 775705
88/206 88/SUBCON/024 88/SUBCON/024 SUBCON FEES-CALIBRATION 775706
88/207 88/SUBCON/025 88/SUBCON/025 SUBCON FEES-WIRE ROPE 775707
88/208 88/SUBCON/026 88/SUBCON/026 SUBCON FEES-HULL STRUCTURE AND FITTING 775721
88/209 88/SUBCON/027 88/SUBCON/027 SUBCON FEES-TANK CLEANING 775722
88/2020 88/SUBCON/028 88/SUBCON/028 SUBCON FEES-RENOVATION OR EXTENSION OF BUILDING 775729



88/SUBCON/029 88/SUBCON/029 SUBCON FEES-MANPOWER SUPPLY 775730
88/200 88/SUBCON/030 88/SUBCON/030 SUBCON FEES-GENERAL 775700

88/017 88/TEST/001 88/TEST/001 NON DESTRUCTIVE TEST (NDT) 777101
88/018 88/TEST/002 88/TEST/002 DESTRUCTIVE TEST (DT) 777102
88/020 88/TEST/003 88/TEST/003 LOAD TEST SERVICES 777103
88/024 88/TEST/004 88/TEST/004 VIBRATION & NOISE TEST 776801
88/025 88/TEST/005 88/TEST/005 AIR & WATER QUALITY TEST,PORT CHEMIST 770210
88/390 88/TEST/006 88/TEST/006 SEA TRIAL 775210

88/014 88/WASTE/001 88/WASTE/001 SCHEDULE WASTE 777250
88/0141 88/WASTE/002 88/WASTE/002 NON SCHEDULE WASTE 777251




